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Abstract 

The combination of searchable database and retention time prediction constitutes a powerful aid 
to method development. Chromatographic databases of successful separations, no matter how 
extensive, rarely contain the exact mixture you would like to separate. In spite of this, such 
databases still contain valuable chemical information that can allow you to propose good initial 
methods to try. For example, you can select a method based on functional group similarities to 
your mixture. Better yet, ACD/Labs predictions allow you to simulate in minutes how your 
compounds would behave under this method. Together, ACD/Labs database and prediction 
software can dramatically speed up method development by allowing you to make chemically 
intelligent choices.  

Introduction 

How can you leverage information for a few chemical compounds to maximize returns by 
reducing method development time?  

A great deal of HPLC method development is still done by trial and error, and you can save time 
by reducing the amount of guesswork. ACD/Labs' software uses stored chemical information and 
fundamental properties predictions to guide your selection toward a viable separation method on 
your first tries. The procedure is outlined below. 

Important To carry out the following method development tutorial, you MUST have 
copies of ACD/LC Simulator and ACD/ChromManager installed in the same 
ACD/Labs software folder. 

As a working example, we are going use our software to find the appropriate conditions for the 
optimal separation in time of the well-known analgesic, diclofenac, from its impurities that are 
shown in Figure 1.  
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Diclofenac A. 1-(2,6-dichlorophenyl) 
indolin-2-one 
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amino]benzaldehyde 

NH

Cl

Cl

OH

 

ONH

Cl

Br

OH

 

N
H

O
 

C. [2-[(2,6-dichlorophenyl) 
amino]phenyl]methanol 

D. 2-[2-[(2-bromo-6-
chlorophenyl)amino] 
phenyl]acetic acid 

E. indolin-2-one 

Figure 1. Structures for a mixture of diclofenac and related impurities.  

 

Tip These structures can be taken from diclofenac.sk2 file that is placed in the 
ACD/Labs examples folder. 

 

To follow this technical note, we recommend that you stick to the example and databases 
provided. This will allow you to gain experience with the procedure before trying it with your own 
databases and proprietary compounds. This method development technique is so simple and 
intuitive, that you will readily be able to apply it to your own compounds and databases.  
 

This document assumes that you are familiar with ACD/ChemSketch and with using our program 
interface. The interface was designed to be as intuitive as possible, and you should be able to 
follow without too much difficulty. But if you require a step-by-step tutorial that carefully walks you 
through each step, this is also available on request.  

 

Searching the Applications Database 

In this section, we are going to search the ACD/Chromatography Applications Database 
(appl_db.ndb) to find records containing the structure of diclofenac (or a part of it) in order to find 
separation methods that could be applied for the proposed mixture. 
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1. On the Window Switching Bar of ACD/ChromManager, click Database  to switch 
to the Database Window. 

2. On the File menu, click Open, and in the Open Document dialog box, browse through the 
directories to the location of the appl_db.ndb file. Click OK. The database will open on the 
first record. 

 

Figure 2. Database window open on the first record of the HPLC application database.  

Note The number of records in the ACD/Labs applications database is constantly being 
updated.  On the status bar of Figure 2, you see 450 records, but this is subject to 
change. The total number of records for appl_db.ndb may be bigger in your case.  

3. On the Windows Switching bar, click ChemSketch  to switch to the structure 
drawing area. 
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4. In the ChemSketch workspace, draw diclofenac as shown in Figure 3, or look it up in 
ACD/Dictionary. 

 

Cl
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O

O
-

Cl  

Figure 3. Diclofenac anionic structure (the metal cation should not used in the 
calculation).  

 

5. On the Windows Switching bar, click the Sub-structure Search button  to 
search the open database for this structure.  
Because there is no record containing this particular structure in the current database, the 
program gives you the following message: “No hits found for your query.” 

Note If you have more than one structure in the ChemSketch Window, select diclofenac 
prior to searching.  

On the Structure toolbar, click the Select/Move button , and then click next to 
the desired structure. 

6. If you had used a fragment common to most compounds in your mixture, it is reasonable to 
assume that more hits could have resulted from the search.  So we are going to search 
according to a fragment of diclofenac that is also found in some of the impurities.  In Figure 4, 
we see that N,N-diphenylamine can be obtained from diclofenac or from impurities A, B, C, 
and D in Figure 1. 

In the ChemSketch window, click the Delete button , and then click off the ring 
substituents of diclofenac until you are left with the following. A greater number of “hits” in the 
database might be found, 

 

NH

 

Figure 4. N,N-diphenylamine  

 

7. On the Windows Switching bar, click the Sub-structure Search button .  The 
program compares the fragment against all records in the Chromatography Applications 
Database and informs you that 57 hits were found for this query.  
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Tip Multiple databases can be searched. You can search your own database at the same 
time you are searching the ACD/Chromatography Applications Database.  On the 
Search menu, click Define Multiple DB List, and define the list of databases to be 
searched.  For more details, refer to the ACD/SpecDB User’s Guide. 

 Although looking through 57 hits is better than looking through 450 chromatograms, it would 
be helpful to reduce the number even more.  A careful look at the diclofenac mixture in Figure 
1 shows that impurities A, B, C, and D all share a chlorine substituted phenyl ring.   

8. Return to the ChemSketch Window, and then delete the –NH-Ph groups so that only benzene 
remains. 

9. On the Atoms Toolbar, click  and then add a chlorine group to the benzene ring. 

 Cl  

Figure 5. Chlorobenzene 

 

10. Click on the Sub-structure Search button. 
11. The message “19 hits found for your query” appears.  This is a manageable number, and we 

can now examine each method individually by applying your own judgment on the likely 
suitability of the proposed methods. 

Evaluating the Recovered Method 

Once the database has been narrowed down to just a few chromatograms, you are going to 
evaluate the separations according to other criteria. For example, how similar are the compounds 
to those of your mixture, and do you have a similar column on hand? The sequence of operations 
below assumes that we have narrowed our choices to methods described the file name 
a0936.esp and a0806r.esp. 

Developing Method 

On the Lists menu, click Duplicate, so that both list A and B contain 19 records found in the 
previous search. This will allow us to keep a copy of the original search results. (For more details 
on the operations with search lists refer to the ACD/SpecDB User’s Guide.)  



 

ACD/ChromManager & LC Simulator              Application Notes 8 

 

Searching Database for the Required File 

To find the record described above  
1. On the Search menu (Database Window), click Parameter. The Search Data dialog box will 

appear.  
2. In the Main Condition box, select Includes, and in the Item Name drop-down list, select the 

FileName. Then type a0936 in the Main Value box (see Figure 6). 

  

Figure 6. Search Data dialog box with correct settings for this example.  

 

3. After you click OK, the program switches to the specified file. 

 

Figure 7. Results of database search for Filename a0936.esp. 
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Viewing Conditions of Separation 
1. Double-click the chromatogram to transfer the file to the Chromatogram Window.  You can 

now view all the assignments and other associated data. 
 

  

Figure 8. Chromatogram Window view of the a0936.esp file.  

 

From the Edit menu, click HPLC Parameters to view the column parameters. 

  

Figure 9. Column parameter area cutout for method a0936.esp.  
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2. Under the Elution Data area, click the Solvents button . In the dialog box 
that appears, you can see the solvents data. 

  

Figure 10. Solvent data dialog box for file a0936.esp (from the HPLC Parameters dialog 
box).   

 

 Note that these separation conditions resemble closely those of the European Pharmacopoeia 
for Sodium Diclofenac, 3rd edition [1002] (1): 

 “The chromatographic procedure may be carried out using: 
 —a stainless steel column 0.25 m long and 4.6 mm in internal diameter packed with 

end-capped octylsilyl silica gel for chromatography  R (5 µm),  
 —as mobile phase at a flow rate of 1 ml per minute a mixture of 34 volumes of a 

mixture of equal volumes of a 1 g/l solution of phosphoric acid  R and a 1.6 g/l 
solution of sodium dihydrogen phosphate  R adjusted to pH 2.5 and 66 volumes of 
methanol R,  

 —as detector a spectrophotometer set at 254 nm.” 
3. Click OK to close this dialog box. 
 

Optimizing Chromatogram 
Now you can predict the retention time values for your target compounds (diclofenac and its 
impurities) in this condition.  For this example, let’s assume you want to set up a reversed phase 
separation. 

1. On the General toolbar, click the Optimize Chromatogram button .   
2. The program asks whether you want to optimize chromatogram in the Prediction mode—click 

OK.   This will transfer the structures, retention times, peak width (W), dead time (t0), pH, etc. 
to ACD/LC Simulator.  

3. In the Data Input (Prediction) dialog box, select the Reversed Phase option in the Type of 
Chromatography box, and then click the Calculate Predicting Equation button 
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.  After the calculation is finished, the program 
displays the prediction results 

 
where n = the number of structures used to calculate prediction equation: 
R = the correlation coefficient; 
StD = standard deviation. 
 
The calculated prediction equation generally more reliable  

• With greater number of structures (no fewer than 3–4);  
• When R is close to 1; and  
• When the StD value is close to 0. 

 
The calculated prediction equation is used to extrapolate retention times for our target 
compounds, and uses property calculations based on their chemical structures.  

Tip To print the results, press ALT+PRT SCR (Print Screen) then paste the picture in any 
application (e.g., MS Word or Paint Shop), and on the File menu, choose the Print 
command. 

 

Tip To exclude the structure from calculation, in the Data Input (Prediction) dialog box, 
change the Use column from “+” to “–.” 

                                           
 

4. Click OK to close the results window, and then click OK again to close in the Data Input 
(Prediction) dialog box. 

Predicting New Structures 

After calculating the predicting equation, we want to predict the retention times for our diclofenac 
sample with its impurities. 
1. Return to the ChemSketch Window, and draw diclofenac and its impurities as shown in 

Figure 1.  Or, from the Examples folder open diclofenac.sk2, where the required structures 
have already been drawn for you. 
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2. Select the structures one at a time, and click the Optimizations button  on 
the Window Switching bar.  LC Simulator will predict the retention time for each compound 
using the prediction equation. Repeat until all the compounds in the sample mixture have 
been calculated.  

  

  

Figure 11. LC simulation windows showing peaks for the original method’s compounds 
and for the proposed diclofenac sample mixture. 

 

3. To focus just on the peaks belonging to diclofenac and its impurities, click the Data Input 
button . In the Data Input (Prediction) dialog box, set the setting from “+” to 
“–“ in the View column to hide the experimental structures. 
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Figure 12. Data Input dialog box set to hide the experimental training peaks.  

 

4. Click OK and the chromatogram will be redrawn to show just the new sample compounds of 
interest to you.  

 

Figure 13. Predicted chromatogram for just diclofenac and its impurities based on the 
a0936.esp separation conditions and column parameters. 

 

Figure 13 shows that peak 8 (diclofenac) and peak 10 (impurity B) are poorly resolved.  The 
fact that peaks for impurities 9 and 11 are poorly resolved is of little concern here because we 
gave ourselves the simple goal of isolating diclofenac from its impurities. If separating peak 9 
and 11 had been important, it might be prudent to try to find a different method for this 
separation.  

Note The resolution of the selected peak with the previous and following peaks is shown 
on the Chromatogram Parameters panel (e.g., for the currently selected peak on 
the picture—Pre Rs/Post Rs: 2.84/0.72.) 
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Refining Existing Method 

The objective of the previous section was to provide a viable starting point for the separation. 
Keep in mind that if the method is not entirely satisfactory, that you can refine it.  At this stage, it 
will be necessary to make a judgment call based on your chromatographic experience. But 
instead of going at it blind, you have a chromatogram simulation to guide you. 

Now let us try a different method from the HPLC application database, using different column 
parameters.  

Searching Database for the Required File 

First, we are going to load the 19 records found in the original search into the active list (List A:).   
1. Switch to the Database Window of ACD/SpecDB by using the ACD/Labs menu or by pressing 

SHIFT+ESC on the keyboard. 
2. From the Lists menu, click Switch to interchange the contents of lists A and B. 
3. On the Search menu (Database Window), click Parameter to open the Search Data dialog 

box.  In the Main Value box, type a0806r and click OK.  The program switches to the 
specified file. 

 

 

Figure 14. Results of database search for FilenName a0806r.esp. 
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Viewing Conditions of Separation 
1. Double-click the chromatogram to transfer the information to the Chromatogram Window. 

  

Figure 16. Chromatogram Window view of the a0806r.esp file. 

 

2. On the Edit menu, click HPLC Parameters. Note that the column parameters differ from 
those of the previous example. 

  

Figure 17. Column parameters for method a0806r in the HPLC application database.  
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3. Under the Elution Data area, click the Solvents button and examine the solvent data.  

  

Figure 18. Solvent data dialog box for a0806r.esp file (from the HPLC Parameters dialog 
box).  

 

4. Click OK to close the dialog box. 

Optimizing Chromatogram 

Lets predict the retention time values for diclofenac and its impurities under these new conditions. 
1. On the General toolbar, click the Optimize Chromatogram button. Click OK when to optimize 

in Prediction mode. The structures and retention times will be transferred to LC Simulator. 

Note The program will ask you to save the results of previous calculations.  For the 
current example, skip this step. 

2. In the Data Input (Prediction) dialog box, click Calculate Prediction Equation 

.  After the calculation, the program will display 
the following prediction results. 

  
 The number of structures used for calculation is 4, the correlation coefficient is 1, and 

standard deviation is very close to 0.  The calculated prediction equation thus shows an 
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excellent fit. This equation will be used to extrapolate retention times of our target compounds 
based on their chemical structure properties. 

3. Click OK to close the dialog boxes. 

Predicting the Structures’ Chromatogram 
1. Switch to the ChemSketch Window and draw diclofenac and its impurities, or open 

diclofenac.sk2. 
2. Select structures one at a time, and click the Optimizations button on the Window Switching 

bar.  LC Simulator will predict the retention time for each compound. 
3. To focus solely on peaks belonging to diclofenac and its impurities, click the Data Input button 

and in the Data Input (Prediction) dialog box, set the View column settings from + to – for 
the experimental structures.  Click OK to close the dialog box. 

 

Figure 19. Predicted chromatogram for just diclofenac and its impurities based on the 
a0806r.esp separation conditions and column parameters. 

 

The picture shows us that diclofenac (11) is perfectly separated from its impurities (Pre 
Rs/Post Rs: 2.81/7.23.) 
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Saving Results 

Once you have achieved a satisfactory resolution, the last step is to archive the method for later 
retrieval.  The chromatography data predicted on the basis of similar structures can be saved, 
updated to the user database or printed and then used for comparison with the experimental 
data.   
` 

To archive the chromatogram you should first transfer it to ACD/ChromManager.   

• Click the Copy Chromatogram to ChromManager button  on the Top toolbar to 
switch to ACD/ChromManager (see Figure 20).  

 

Figure 20. Predicted chromatogram of diclofenac and its impurities using method 
a0806r.esp that was exported to ChromManager.  

 

To save the results on disk 

• On the File menu, click Save. 
—OR— 

• You can also export the file to ASCII (.txt) and NetCDF (*.nc, *.cdf) formats by means 
of Export… command from the File menu. 

To update the chromatogram to the database  

• First open or create a user database, switch to ACD/ChromManager, and then click 

the Update Database button  on the General toolbar.  For more details see the 
ACD/SpecDB User’s Guide. 

Tip User data fields are shown in the right-aligned Parameters sub-window corner of the 
Database Window.  You can define your own fields, and you can semi-automate the 
introduction of these fields using ACD/Data Forms Manager (for more information on 
creating database forms refer to the separate guide.)   
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Conclusion 
No matter how big we make the ACD/Labs applications database, this is nothing compared to the 
results you will get if you create your own database. A database built from your work and that of 
your colleagues will greatly increase the number of relevant experiments to draw from. This 
allows you to build on previous successes and avoids reinventing experiments that had already 
been worked out before. For the two or three seconds that it takes to put a separation in a 
database, you can save days of work later on.  

The combination of a searchable database and retention time prediction is a truly powerful 
method development tool.  The database is an “anchor to reality” and while it is unlikely to contain 
your unique mixture it does give you relevant information for your new method development. The 
predictions, based on chemical functional groups, give you a very good first approximation of how 
the method will work out. Together, these two tools dramatically speed up your method 
development time by avoiding methods that are not suited to your needs, and by allowing you to 
do refinements before the first run.  
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